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1—Getting Started

Welcome to Portfolio 3.0, a simple but efficient cataloging tool that
organizes all your creative work into browsable, on-line libraries. This
chapter describes new features since Fetch 1.5, basic concepts, how to
install Portfolio, getting started with catalogs and converting Fetch
catalogs for use in Portfolio.

Using this manual
Once you’ve read through this chapter and understand the basic
cataloging concepts, you can proceed to the remaining chapters in
this manual:

• For detailed information on using Portfolio’s cataloging features,
see Chapter 2, “Using Catalogs.”

• For information on creating and managing catalogs for yourself or
others, see Chapter 3, “Creating and Managing Catalogs.”

• For details on catalog maintenance and administering catalogs for a
workgroup, see Chapter 4, “Catalog Administration.”

• For Portfolio hotkeys and shortcuts, see Appendix A.

• For helpful Portfolio case studies, see Appendix B.

Portfolio 3.0 is a fully cross-platform product. While most features
work identically on the Macintosh and in Windows, a few minor
differences do exist. We’ve placed icons in the left margin of this
manual to alert you to those situations:

This icon indicates a feature available only in the Macintosh version of
Portfolio or a section that pertains to Macintosh functionality.

This icon indicates a feature available only in the Windows version of
Portfolio or a section that pertains to Windows functionality.

M
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What’s new in Portfolio version 3.0
Portfolio 3.0 is the next stage of Extensis Fetch, the longtime catalog-
ing standard for creative professionals. More than simply a new version
of an existing product, Portfolio takes the Fetch technology to a new,
more powerful level.

If you used Fetch in the past, you’ll still get all the powerful features
you’re accustomed to. In addition, Portfolio includes the following
improvements and new features:

Cross-platform functionality

Portfolio is the first truly cross-platform cataloging product available.
This means that the same catalog file can be used simultaneously in
Windows or on the Macintosh, with no conversion required.

Translator support

Portfolio uses a translator system that allows it to read and display
approximately 30 different image formats. This is particularly impor-
tant for cross-platform use, where Windows applications cannot always
use the thumbnail image and keywords many Macintosh applications
store in their files.

Multi-user access

Portfolio uses a new database engine designed to handle cross-platform
data. Additionally, the database uses “record-level locking,” which lets
multiple users add and edit items in a catalog simultaneously.

Redesigned interface

The Portfolio interface has been redesigned for a more intuitive user
experience. This allows you to quickly and easily access more
information.

Customizable views

You can now specify which fields are displayed in a Gallery window,
both in the Thumbnail and List views. This lets you easily view only
the information that’s important to you.

In addition, you can alter the background color, text color, font, and
thumbnail size of your Gallery windows, as well as rotate thumbnails
so that you can view scanned images in their proper orientations.

Improved keywords

You now have greater control over keywords, especially when working
with multiple items at once. The “Edit Keywords” dialog box has been
revised to let you view the keywords associated with more than one
item simultaneously.
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Master Keyword List

Portfolio includes the Master Keyword List, a predefined list of
keywords created by the catalog administrator. By restricting users to
adding only keywords from this list to an item, administrators can
guarantee that only accepted keywords are used within a catalog. The
floating Master Keyword Palette lets users assign keywords to one or
more items simply by dropping them onto item thumbnails.

Multiple security levels

Portfolio offers four levels of security, allowing catalog administrators
to restrict access to specific catalog functions.

Custom fields

Traditionally, catalogs have been limited to a fixed number of informa-
tion fields such as keywords and descriptions. Portfolio lets you create
an unlimited number of custom fields to provide context for your
catalog information. For example, if you create a Photographer field
and a Location field, you can search the Location field for “Washing-
ton” without fear of finding photos taken by a photographer named
Washington.

Multiple catalogs

Portfolio can open any number of catalogs simultaneously, allowing
you to quickly copy items from one catalog to another without losing
keywords, descriptions and other vital information.

Gallery enhancements

Portfolio Galleries can contain any set of items, not just a set resulting
from a search. Multiple Galleries can be open simultaneously, and you
can add items to one Gallery by dragging them from another Gallery.
Galleries can also be saved, which allows distinct sets of items to be
opened as a group; saved Galleries also retain custom formatting.

Portfolio concepts
Portfolio allows you to take images—graphics, presentations, movies,
sounds, and other digital media files—that you or members of your
workgroup create and put them into a common catalog. You can then
view, edit, copy, and retrieve the files from the catalog and transfer
them to other documents, regardless of file format, location, platform,
or the applications that created the files.

Portfolio catalogs store thumbnail images rather than full document and
image files, and create pointers to the original files. Because Portfolio
does not store the files themselves, using a catalog is fast and efficient.
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There is no limit to the number of items a single catalog can contain
(bearing in mind that the more items in a catalog, the more memory and
time are required for common operations). To each item in a catalog,
you can add:

• An unlimited number of keywords that let you easily search
a catalog.

• A description (up to 32,000 characters long) that lets you store
important or useful information about the file.

• Data in custom fields.

In a workgroup setting, you can allow all users full access to all
functions, or you can designate catalog administrators to create,
maintain, and control access to catalogs for the entire workgroup. With
Portfolio installed on their computers, members of your workgroup can
simultaneously search, view, and use items from catalogs whose source
files are located on one or many network servers, shared volumes, CD-
ROMs or removable drives.

Note: If you need to make your catalogs available to users who don’t
have Portfolio, you may want to consider the Portfolio Content
Publisher’s Toolkit and Portfolio read-only browser, also available from
Extensis. For details on this product, call (800) 796-9798.

Installing Portfolio
Installing Portfolio is simple—the installer application does all the
work for you, and puts all the Portfolio files where they belong on your
hard disk.

System requirements
To install and use Extensis Portfolio, you need the following:

• 68030-based Macintosh or newer (including Power Macintosh and
compatibles), or 486/33 or higher IBM or 100% compatible PC

• Mac OS 7.5 or later, or Windows 95 or NT 4.0 or later

• 6MB of application RAM minimum

• 20MB free hard disk space

Note: If you commonly work with large files or large catalogs, you may
need to increase the amount of RAM allocated to Portfolio.M
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Macintosh installation
Before installing, restart your Macintosh with all extensions off (except
for your CD-ROM extensions).

To install Portfolio on your Macintosh:

1. Insert the Extensis CD-ROM into your CD-ROM drive.

Note: Other Extensis products are available for you to install from
this CD. These are full working versions of Extensis products that
you can run in Demo mode. Call Extensis at (800) 796-9798 to
purchase a serial number that will allow you to use these programs
with no time restrictions.

2. Open the Portfolio folder.

3. Double-click the installer icon.

The Introduction dialog box appears.

4. Click “Continue.”

The Welcome dialog box appears. Release notes and special
instructions are displayed in this window. It is important that you
read these release notes since they contain information not included
in the manual. You should save or print these release notes before
continuing the installation.

5. Click “Continue.”

The Installation dialog box appears.

6. Click “Install.”

The Disk Selection dialog box appears. The dialog box requests that
you select the disk on which you want Portfolio installed.

7. Select the disk and folder where you want Portfolio installed.

8. Click “Install.”

Once installation is complete, the successful installation dialog box
appears. The installer will prompt you to restart your computer if
necessary.

M
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Windows installation
Before installing, be sure to turn off any anti-virus software.

To install Portfolio in Windows:

1. Insert the Extensis CD-ROM into your CD-ROM drive.

Note: Other Extensis products are available for you to install from
this CD. These are full working versions of Extensis products that
you can run in Demo mode. Call Extensis at (800) 796-9798 to
purchase a serial number that will allow you to use these programs
with no time restrictions.

2. Open the Portfolio folder.

3. Double-click the Setup icon.

The Portfolio Setup dialog box appears.

4. Click “Next.”

5. Select the disk and directory where you want Portfolio installed.

If you want to change from the default location, click “Browse” and
choose a new disk and/or directory.

6. Click “Next.”

Portfolio is installed to the location you specified.

7. Click “Finish” to launch Portfolio and view the ReadMe file.

Registering Portfolio
It is important to register your copy of Extensis Portfolio so that you
are eligible for technical support, information regarding new versions,
products, discounts and special offers on new products.

Portfolio includes electronic registration. The first time you launch
Portfolio after installing it, a personalization dialog box appears. Enter
your name, company and Portfolio registration number. Your product
registration number is located on this manual. If you choose not to
personalize your copy, Portfolio will run in a 60-day demonstration
mode. A dialog box will remind you of how many days are remaining
in the demonstration mode each time you launch Portfolio.

W
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Once you have personalized Portfolio, a dialog box appears asking if
you would like to register. To register, click the “Register Extensis
Portfolio” button; an electronic registration screen appears. After
you’ve completed the registration screen, a Market Research screen and
a System Configuration screen appear. The Market Research screen
asks basic questions that enable us to better understand your needs. The
System Configuration screen provides a “snapshot” of your system
configuration that enables Extensis to support you more effectively.
Sending this information is optional; if you do not wish to send it to
Extensis, select the checkbox at the bottom of these screens.

To use electronic registration, you must have a modem connected to
your computer. Portfolio will dial the number automatically, and the
call is toll-free. If you do not have a modem, you can print the registra-
tion screen and register either by faxing it to (503) 274-0530 or mailing
it in the postage-paid envelope provided. If you don’t have access to a
printer, you can still register by filling out the registration sheet located
at the end of this manual.

Using Technical Support
For questions regarding Portfolio, please refer to this manual first—it
describes all of Portfolio’s features and basic operations. In addition,
you can find frequently asked questions and troubleshooting tips on the
Portfolio page of the Extensis World Wide Web site, at
www.extensis.com.

If you have a problem that is not addressed in this manual or on the
Extensis Web site, technical support is available at (503) 274-7030,
Monday through Friday 8:00 a.m. to 5:00 p.m. Pacific time.

Extensis provides free support to registered users on a limited basis,
and extended support is also available. For information on extended
support, please visit our Web site or call Extensis Technical Support at
(503) 274-7030.

Suggestions

We’d love to hear your comments about Portfolio. For your conve-
nience, a suggestion sheet is included at the end of this manual. Please
fax, mail, or e-mail your comments and suggestions to Extensis.
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Getting started cataloging your files
Now that you’ve installed Portfolio, you’d probably like to catalog one
or more of your files to see how Portfolio displays them.

To catalog your files:

1. Double-click the Portfolio icon.

A dialog box appears, prompting you to open an existing catalog or
create a new one. Since you have not yet created a catalog, select
“Create a new Portfolio catalog” and click “OK.” A directory dialog
box appears.

Note: If you don’t have any files to catalog yet, you may want to
select “Open an existing Portfolio catalog” instead, and open the
sample catalog included with Portfolio. See “Using the sample
catalog” later in this chapter for details.

2. Specify a name and location for your catalog, then click “Save.”

Portfolio creates a catalog file, which it stores on your hard drive.
The catalog’s Gallery window opens.

3. Drag and drop selected files or folders into the catalog.

Select a file or folder from the Finder or Explorer and drag it into
the Gallery window. When the window is highlighted, release the
file or folder. The “Catalog Properties” dialog box appears with the
Options tab open.

4. Click “OK.”

The “Catalog Properties” dialog box lets you choose a variety of
options when you catalog files. For this procedure, as for most files,
the default settings should be fine. (For more information about
adding and updating options, see “Setting catalog update options” in
Chapter 3, “Creating and Managing Catalogs.”)

Next, the Cataloging Status window appears. This window shows
the files as they are being added to the catalog. In this window,
you’ll see a small picture (or thumbnail) of each file, as well as the
number of files that were cataloged and their locations.

5. View your files.

You should now see all the files that you cataloged in the Gallery
window. If you cataloged files that do not contain thumbnails (such
as text files), you will see a file icon instead of the thumbnail.

The items in the Gallery window are only references to the actual,
or “source” files. The files themselves can be stored anywhere.
However, to accomplish certain tasks in Portfolio you will need
access to the source files.
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Using the sample catalog
If you have not yet cataloged your own files, or if you’d like to work
with other file types (such as movies and sounds) that you may not yet
have, you can use the Portfolio sample catalog. A Sample Catalog
folder was placed in your Extensis Portfolio folder during installation.

Note: The Sample Catalog folder contains the catalog, but not its
associated files. Those files are located on the Extensis CD-ROM from
which you installed Portfolio.

To open the sample catalog:

1. Insert the Extensis CD-ROM into your CD drive.

2. Double-click the Sample Catalog icon in the Sample Catalog
folder located in your Extensis Portfolio folder.

The catalog’s Gallery window appears.

Converting Fetch catalogs
You can convert Fetch version 1.5 catalogs or Fetch 1.2 multi-user
catalogs for use in Portfolio 3.0 on the Macintosh.

To convert a Fetch catalog:

1. Open Portfolio.

2. Choose “Open…” from the File menu.

A directory dialog box appears.

3. Locate the Fetch catalog you want to convert and click “Open.”

A dialog box appears, asking if you want to convert the Fetch
catalog to Portfolio format.

4. Click “OK.”

A second directory dialog box appears.

5. Specify a name and location for the converted catalog and click
“Save.”

The catalog is converted to Portfolio 3.0 format and saved in the
location you specified. You can now use it in Portfolio. The earlier
catalog is preserved in its original location.

end

M
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This chapter describes how to open Portfolio catalogs, search for items,
and select, preview, and use those items in a variety of ways. You’ll
also learn some techniques for getting the most from Portfolio.

This chapter assumes that you have an existing catalog with which to
work. If you do not, you can use the Sample Catalog installed in your
Portfolio folder; see “Using the Sample Catalog” in Chapter 1, “Getting
Started,” for details.

Opening Portfolio
You can open Portfolio and a catalog in any of three ways.

To open Portfolio:

• Drag a catalog icon onto the Portfolio application icon until
both icons are highlighted, then release.

or

• Double-click a catalog icon.

or

• Double-click the Portfolio icon, then choose “Open…” from the
File menu.

If you have set a default catalog, double-clicking the Portfolio icon
automatically opens that catalog. If not, you are prompted to create
a new catalog or open an existing one.

The catalog opens to the Gallery window, where you can open one or
more Preview windows and Item Properties dialog boxes that let you
view more information about individual items. The Gallery window
can also function as a temporary work space for items collected from
different searches.

Note: If you open a protected catalog, you must enter the appropriate
access password to view and modify the catalog items. If the catalog
won’t open, another user may have it open in Administrator mode, or
with the Portfolio browser. See “Catalog access levels” in Chapter 4,
“Catalog Administration,” for details.

2—Using Catalogs
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Find window: Lets you
describe what you want
Portfolio to display in the
Gallery window, whether you
want all the items in the catalog
or only items meeting particular
criteria. For more information on
searching, see “Searching a
catalog” later in this chapter.

Windows and dialog boxes in Portfolio

Gallery window/Thumbnail view:
Shows a separate thumbnail
image of each item, with item
information below the thumbnail.
For more information about the
Gallery window, see “Using Gallery
windows” later in this chapter.

Gallery window/List view: Lists
the items currently in the Gallery,
one row for each item. Also shows
the thumbnail, keyword list, and
description for the selected item.
For more information about the
Gallery window, see “Using Gallery
windows” later in this chapter.
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Preview window: Displays a
full-size preview of the item
(unless “scale-to-fit” is selected).
Portfolio must be able to locate
the source file before displaying
the preview. For more
information about previewing
catalog items, see “Previewing
an item” later in this chapter.

Item Properties dialog box:
Displays all of the information
about an item that the Portfolio
database contains, or that can
be read from the source file. To
learn more about the Item
Properties dialog box, see
“Viewing item or catalog
information” later in this chapter.

Windows and dialog boxes in Portfolio (continued)

Catalog Properties dialog
box:  Provides summary
information about the entire
catalog. For more information
about the Catalog Properties
window, see “Viewing item or
catalog information” later in this
chapter.
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Master Keywords Palette:
Allows you to view the Master
Keywords for all items in a
catalog. The palette displays
Master Keywords alphabetically,
and can be placed anywhere
onscreen. For more information,
see “Viewing keywords” in
Chapter 3, “Creating and
Managing Catalogs.”

Windows and dialog boxes in Portfolio (continued)

Catalog Administration dialog
box:  Allows catalog administrators
to create and maintain Master
Keywords, assign catalog
passwords and define custom
fields. See Chapter 4, “Catalog
Administration,” for details on
administering Portfolio catalogs.

Missing Files dialog box: Lists
the file references in a Portfolio
catalog that are no longer valid.
See Chapter 4, “Catalog
Administration,” for details on
finding missing files.
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Edit Keywords dialog box:
Allows you to edit item
keywords for one or more items
at a time. You can add keywords
to and remove keywords from
more than one item, and you
can quickly assign a keyword to
several items at once. See
“Entering and editing keywords
manually” in Chapter 3,
“Creating and Managing
Catalogs.”

Windows and dialog boxes in Portfolio (continued)

Customize Gallery dialog box:
Allows you to change the layout
of a Catalog’s Gallery windows.
You can specify precisely the
information you want to display
in both the Thumbnail and List
views, including any information
in custom fields. In addition, you
can alter thumbnail size and
appearance, set a different
background color for the window
and more. See “Customizing
Gallery windows” later in this
chapter.
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The Portfolio Toolbar

C

B

A E

A New: Click to create a new catalog.

B Open: Click to open an existing
catalog.

C Always on Top: Click to keep the
Portfolio application window
frontmost, even when another
application is active.

D Help: Click to open the Portfolio
online Help index.

E QuickFind combination box: Type a
word to match in a search, or
choose a previously entered word.
QuickFind uses the “starts with”
search criteria; see “Searching a
catalog” later in this chapter for more
information.

F QuickFInd: Click to perform a search
on the word in the QuickFind
combination box, and displays the
results in the current Gallery. (You
can set QuickFind results to appear
in new Galleries; see “Setting
preferences” later in this chapter for
details.)

G Find: Click to open the Find window.

H New Gallery: Click to create a new
Gallery window for the active
catalog.

I Saved Galleries: Click to open and
choose from a list of saved Galleries
for the active catalog.

J Saved Finds: Click to open and
choose from a list of saved finds for
the active catalog.

FD

G I

JH

W The Portfolio toolbar
The Windows version of Portfolio includes a toolbar on the application
window. The toolbar makes many of Portfolio’s commonly used features
available at the touch of a button, and provides access to QuickFind, a
fast way to find items in a catalog without opening the Find window.

You can leave the toolbar on the Portfolio application window, or you
can “tear” it off as a free-floating palette. The toolbar features are
described in detail below.
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Searching a catalog
Use the Find window to tell Portfolio which catalog items you want to
see. You can search any field, including custom fields (see “Using
custom fields” in Chapter 3, “Creating and Managing Catalogs,” for
more information on custom fields).

You will probably find that you use different search strategies at
different times. For example:

• If your catalog is small or you’re looking for ideas, you might start
by looking through everything the catalog contains.

• If your catalog is very large or you have a general idea of what
you’re looking for, you might want to look only at items related to a
particular subject or concept, or of a particular file type.

• If you’re in the final stages of a job, you probably know exactly
what items you need.

Portfolio displays the results of the search in a new Gallery window or
in the current Gallery window, completely replacing the previous
contents (if any).

To display the entire contents of a catalog:

• Choose “Find All” from the Catalog menu.

or

• Click “Find All” in the Find window.

To find specific items in a catalog:

1. Choose “Find…” from the Catalog menu.

Portfolio opens the Find window and displays the default saved
find.

2. Use the Find window as shown on the following page to describe
what you are looking for, then click “Find.”

Portfolio lets you search for various attributes of an item, including
filename, keyword, file size and so on. See the table later in this
section for descriptions of the attributes you can use in your search.
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Enter a single search description for a
simple search.

A Search criteria.

B Specify whether to save the search
criteria for later use. See “Saving
finds” later in this chapter for details.

C Choose the search criteria. (If you
are searching by volume, it doesn’t
need to be mounted before starting
the search.)

D Choose an option to focus the
search criteria.

E Type a word or part of a word to
search for here.

F Check to search only the open
gallery window.

G Click to expand the number of
search criteria.

H Check to display the search results
in a new gallery window.

I Click to find all items.

J Click to start the search.

Click “More Choices…” in the basic
Find window to display the expanded
window. Click as many as four times to
add more criteria fields.

A Choose “and” to narrow the search;
“or” to broaden it.

B Choose the additional search
criteria.

C Click to reduce the number of search
criteria.

C

A

F

G

ED

C

H J

Use the expanded Find window for a more complex search

Use the basic Find window for a simple search

A

B

The Find window

B

I
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This option… Finds…

Cataloged* The date an item was first cataloged in Portfolio

Created* The date the item was created

Extension Win* (Windows only) The item’s three-character file extension

Description The item’s file description

File Size The item’s file size

Filename* The item’s name

Keywords* Any keywords assigned in Portfolio

Last Modified The date of the item’s last modification

Last Updated The date the item was last updated in the catalog

Creator Mac (Macintosh only) The four-character file creator code for the item

File Type Mac* (Macintosh only) The four-character file type code for the item

Path The file path (location) for the item

Short Filename Win (Windows only) The eight-character filename for the item

Volume* The physical drive or disk on which the item resides

Custom Fields Any custom fields that have been created for the current catalog

*These fields are indexed for faster searching.

Portfolio search criteria options

Streamlining your searches
Portfolio has several options that can help you search through a catalog
quickly and effectively. For example, you can:

• Choose the most efficient searches for Portfolio to carry out.

• Name and save frequently used searches (to save yourself from
having to re-enter the criteria each time).

• Customize the default search displayed when you the Find dialog.

Searching more efficiently
Searches performed on indexed fields are always faster because
Portfolio uses indexes built into the database; on the Macintosh,
indexed fields appear in bold in the search criteria pop-up menu. When
you search on indexed fields, choose “matches” from the modifier pop-
up menu for the fastest searches, or “starts with” for searches that are
nearly as fast.
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Other types of searches may be somewhat slower because Portfolio
must examine every entry in the catalog:

• Searching on file type or volume is slower when there is a large
number of items that match your search criteria.

• Searching on keyword or filename using “contains” or “ends with”
can be slower when the catalog is large.

Volumes referenced in the catalog need not be mounted before you
search.

Saving finds
If you routinely use a particular set of items in a catalog, you can name
and save a find that retrieves those items.

Your saved finds appear in the Saved Finds pop-up menu in the Find
window. Whenever you want to use a saved find, choose its name from
the menu.

To save a find:

1. Set up your search in the Find window.

2. Choose “Save As…” from the Saved Finds pop-up menu.

3. Type a name for the new definition in the “Find Name” dialog
box that appears.

4. Click “OK” to return to the Find window.

Portfolio stores the search definition you just created in the catalog.

Using the default find
You can edit the default find so that it retrieves the items you use most
often. Portfolio carries out the default find the first time you open a
catalog after starting the application or whenever you choose “Default”
from the Saved Finds pop-up menu.

To change the default find:

1. Set up the search you want to use as the default in the Find
window.

2. Choose “Save as Default” from the Saved Finds pop-up menu.

You can change the default find as often as you want.
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Editing saved finds
You can change the criteria of your saved finds, rename them, duplicate
them or delete them. You cannot rename or delete the default find.

To change the attributes of a saved find:

1. Choose the find you want to change from the Saved Finds pop-
up menu.

2. Modify the search criteria and choose “Save” from the Saved
Finds pop-up menu.

The new search criteria are applied to the saved find.

To rename or delete a saved find:

1. Choose “Edit List…” from the Saved Finds pop-up menu in the
Find window.

The “Saved Finds” dialog box appears.

2. Select the saved find you want to edit in the list.

3. Click the appropriate button to rename, duplicate or delete the
find.

4. Click “OK” to return to the Find window.

The changes are made to the saved find.

Using Gallery windows
Portfolio displays catalog items in Gallery windows. You can see
Gallery windows in Thumbnail view for visual browsing, or List view
for text browsing (List view can display more information about the
items).

In either view, you can scroll and select items to preview, print, edit, or
use in other documents. You can customize Gallery window appearance
for both Thumbnail and List views; see “Customizing Gallery win-
dows” later in this chapter for details.

You can also save Gallery windows for future use once they contain the
items you want. See “Saving Gallery windows” later in this chapter
for details.
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Thumbnail view shows a small thumbnail
image and minimal text information for
each item in the window. Resize the
window to see more or fewer thumbnails
at once. Scroll to see thumbnails not
currently visible.

A Displays the name of the open
catalog, and the number of the
current Gallery.

B Displays the number of items found
from the latest search.

C Displays the thumbnails or icons of
the items in the catalog, along with
information about each item.

B

A

C E

D

Gallery views

C

A

B

List view lists the items in the catalog in
the top half of the window, and shows a
thumbnail, keyword list, and description
of the selected item in the bottom half.
Scroll the list box to see items not
currently visible.

A Displays the name of the open
catalog.

B Displays the number of items found
in the latest search.

C Displays the selected item’s
thumbnail.

D Displays the selected item’s
keyword list (double-click a keyword
in this list to do a quick search for
that keyword).

E Displays the selected item’s
description.
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To do this… Follow this procedure…

Sort the items in the window Click a column heading (List View) or choose one of the “by” commands from
the View menu. The default is the order in which the items were added to the
catalog; catalogs cannot be sorted on unindexed fields. The List view reverts
to “view by order” after each search.

Select an item Click its row (List View) or thumbnail (Thumbnail View). To add another item to
the selection, press Command (Macintosh) or Ctrl (Windows) and click the
item. To select all items between the last and current item, press Shift and click
on the item.

Preview an item Select the item, then double-click its thumbnail or choose “Preview Original…”
from the Item menu.

Display an item’s properties Select the item and choose “Item Properties…” from the Item menu.

Edit an item’s source file Select the item and choose “Edit Original” from the Item menu.

Edit an item’s keyword list Select the item, choose “Item Properties…” from the Item menu and edit the
keywords in the Keywords tab.

Edit multiple items’ keyword lists Select the items, then choose “Edit Keywords…” from the Item menu.

Copy items into another Gallery Drag the thumbnail or row and drop it in the other Gallery window. If the
Gallery window belongs to another catalog, the item is copied to the catalog
(unless it already exists).

Reorder items in the Gallery window Drag the thumbnail and drop it where you want the item to appear.

Portfolio Gallery options

Customizing Gallery windows
You can change the layout of a Catalog’s Gallery windows. This allows
you to display precisely the information you want in both the Thumb-
nail and List views, including information in custom fields.

To customize Gallery windows:

1. Choose “Customize…” from the View menu.

The “Customize Gallery” dialog box appears. Depending on the
Gallery window’s current view, the Thumbnail or List tab is open.

2. Select the options you want.

The view options are described in the table below.

3. Click “Apply” to apply the changes you made to the current
view, without closing the “Customize View” dialog box.

4. Click “OK” to apply the changes you made and close the
“Customize View” dialog box.

Note: Click “Save Defaults” if you want to save the current settings
as the default layout. The layout is used for all new Galleries.
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Option Choices Description

Types Font Sets the display font for the view.
Size Sets the font size for the view.
Style Sets the font style for the view.

Thumbnail Size Sets the size of the thumbnails in Thumbnail view.
(This setting affects only the display of the
thumbnail, not its original size.)

Space Between Sets the number of pixels between thumbnails in
Thumbnail view.

Background Color Sets the window background color in Thumbnail
view.

Text Color Sets the color of the text in Thumbnail view.

List Background Color Sets the window background color in List view.
Text Color Sets the color of the text in List view.

Fields list A scrolling list of all available fields in the catalog.
Select a field name to have it appear in the
current view. On the Macintosh, drag field names
to rearrange their order in the list; in Windows,
use the “Move Up” and “Move Down” buttons.

In Thumbnail view, the Filename field is selected
by default. In List view, the Filename, File Size,
Last Modified, Volume and File Type (Mac) or
Extension (Win) fields are selected by default.

Saving Gallery windows
Once a Gallery window contains the items you want in the layout you
want, you can save the window for future use. For instance, you may
want to create a Gallery of items to show to prospective clients.

To save a Gallery:

1. Make sure the Gallery window contains all the items you want,
in the layout you want.

You can find items to add to the current Gallery window, or to
create a new window; see “Searching a catalog” earlier in this
chapter for details. See the preceding section, “Customizing Gallery
windows,” for information on changing Gallery window layouts.

2. Choose “Save Gallery…” from the Catalog menu.

The “Save Gallery” dialog box appears.

3. Type a name for the Gallery window and click “OK.”

The Gallery window is saved for later use.

Gallery customization options
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Note: The name you specify for the Gallery does not appear at the
top of the Gallery window. Instead, each Gallery for a catalog is
numbered in the order in which it was created, and that number
appears in the window’s title bar with the catalog name.

To open a saved Gallery:

1. Choose “List Galleries…” from the Catalog menu.

The “Saved Galleries” dialog box appears.

2. Select the Gallery you want to open in the list box, then click
“Open.”

The Gallery window you selected opens. (You can also double-click
a Gallery name to open it and automatically close the dialog box.)

3. Click “Done” to close the “Saved Galleries” dialog box.

To edit a saved Gallery:

1. Choose “List Galleries…” from the Catalog menu.

The “Saved Galleries” dialog box appears.

2. Select the Gallery you want to edit.

3. Click “Rename…” to rename the selected Gallery, or click
“Delete” to remove the saved Gallery from the catalog.

4. Click “Done” to close the “Saved Galleries” dialog box.

Using default Galleries
You can set up your catalog so that a specific gallery is displayed when
the catalog is initially opened. This is known as the default gallery.

To create a default Gallery:

1. Make sure the Gallery window contains all the items you want,
in the layout you want.

You can find items to add to the current Gallery window, or to
create a new window; see “Searching a catalog” earlier in this
chapter for details. See the preceding section, “Customizing Gallery
windows,” for information on changing Gallery window layouts.

2. Choose “Save Gallery…” from the Catalog menu.

The “Save Gallery” dialog box appears.

 3. Type “Default” in the “Save Gallery” dialog and click “OK.”

Tip

If you open a saved Gallery that
contains items that have been
deleted from the catalog since
the last time the Gallery was
saved, an “Item Deleted” icon
appears in place of the items’
thumbnails. Choose “Refresh”
from the Catalog menu to
remove these icons from the
Gallery.
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Previewing an item
When you want to look more closely at any image or play sound or
movie items, you can open a Preview window for an item in Portfolio.
This saves you from having to launch the application that the item’s
source file was created in. You can have up to ten Preview windows
open at a time.

Before displaying an item in a Preview window, Portfolio must be able
to locate the item’s source file—that is, the original file from which the
catalog entry was made. Portfolio alerts you when a source file cannot
be located.

To preview an item:

• Double-click its thumbnail in the Gallery window.

or

• Select the item, then choose “Preview Original…” from the Item
menu.

Note: Some file types cannot be previewed. If Portfolio is unable to
preview a file type, you are prompted to view the file in the application
that created it. See “Working with an item’s source file” later in this
chapter for details.

The Preview window lets you display and manipulate an item in
various ways depending on the item’s type (image, sound or movie), as
described in the following pages.

Previewing multimedia files in Windows
Instead of opening a Preview window for movies, sounds and 3D
images, Portfolio uses Windows’ built-in player applications for
multimedia files. This applies to the following file types:

• .avi—Windows video files

• .mov—QuickTime movie files

• .snd—Macintosh sound files

• .aif—Apple AIFF sound files

• .wav—Windows sound files

• .mid—MIDI sound files

W
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To do this… Follow this procedure…

Select a portion of the image Drag a box around the area.

Select the whole image Choose “Select All” from the Edit menu.

Increase magnification Press Shift and click the image.

Decrease magnification Press Option (Macintosh) or Ctrl (Windows) and click the image.

Return the image to actual size Press Shift+Option (Macintosh) or Shift+Ctrl (Windows) and click
the image.

Increase both magnification and window size Choose “Zoom In” from the Item menu.

Decrease both magnification and window size Choose “Zoom Out” from the Item menu.

Return image to actual size (100%) and adjust Choose “Actual Size” from Item menu.
window size to fit

Edit the image’s source file Select the item and choose “Edit Original…” from the Item menu.

Create a copy of the image file Choose “Copy Original…” from the Item menu.

Copy the image to the Clipboard Choose “Copy” from the Edit menu.

View the item’s properties Choose “Item Properties…” from the Item menu.

Previewing still images

A

B

D

E

F

A still image initially appears in a
Preview window either at actual size
(100% magnification) or scaled to fit a
window appropriate to your screen size,
depending on your preferences settings.

A File name of the item in the window

B Image size in pixels  (Not available for
all file types)

C Image resolution (Not available for all
file types)

D Current magnification

E Partial image selection area

F Preview window cursor

C
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To do this… Follow this procedure…

Select part of the movie Press Shift and drag within the control bar (selected frames appear
highlighted).

Play or pause the movie Click the play button or press the spacebar. You can also double-click the
movie to play and click it to pause.

Control playback speed Press Control and click either of the step buttons.

Step forward or backward one frame Click the forward or backward step button, or press the right or left arrow key.

Increase or decrease volume Click the volume control and adjust the slider, or use the up and down
arrow keys.

Edit the movie’s source file Choose “Edit Original” from the Item menu.

Create a copy of the movie file Choose “Copy Original…” from the Item menu.

Copy the movie to the Clipboard Choose “Copy” from the Edit menu.

View the movie’s properties Choose “Item Properties…” from the Item menu.

On the Macintosh, a movie item
appears in the Preview window at its
actual size with a standard QuickTime
control bar that lets you start, stop, and
step through the movie; select frames;
and control the volume. You cannot
resize a movie preview.

A Movie duration

B Filename of the movie in the window

C Movie window

D Play button

E Volume control (if movie has sound)

F Options drop-down menu

G Control bar

H Step buttons

Previewing movies (Macintosh)

A B

C

D

E

HG

F
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Previewing sounds (Macintosh)

On the Macintosh, a sound item in the
Preview window appears and works
much the same as a movie item, except
that there is no visual component. The
control bar lets you start, stop and step
through a sound item; select part of the
sound item; and control the volume.

A Filename of the sound in the window

B Sound duration

C Volume control

D Sound pop-up menu

E Control bar

F Step buttons

All of the procedures for movies also
work for sounds.

D

A

B F

E

A QuickDraw 3D image is a three-
dimensional drawing that can be
cataloged with Portfolio (available only
on Power Macintosh or compatible).

A Click to select a particular view from
a pop-up menu.

B Views pop-up menu.

C Click to enlarge (magnify) or reduce
the image in the window.

D Click to spin the model in 3D space.

E Click to move the object around
inside the window.

Previewing QuickDraw 3D images (Macintosh)

DCB A E

C
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Important

In a multi-user setting, be
careful about moving or deleting
source files unless you are sure
that your entire workgroup
wants the files moved or
deleted.

Tip

To edit the source file in an
application other than its
creator, press Option
(Macintosh) or Shift (Windows)
while choosing “Edit Original…”
from the Item menu. Choose
the application you want to
open it in from the directory
dialog box that appears. The
new application becomes the
one that Portfolio associates
with the file type until you
change it again.

Working with an item’s source file
Once you have identified a catalog item you want, you can work with it
from within the open catalog. For example, you can:

• Switch to another program to edit the source file (the original file to
which the catalog entry points).

• Move, copy, or delete the source file.

• Copy the item to the Clipboard, switch to another program, and
paste the item in a document.

• Find out more information about the item.

• Print thumbnails or the item itself.

To edit an item’s source file:

1. Select the item in the Gallery window, or open a Preview
window for the item.

2. Choose “Edit Original…” from the Item menu.

Portfolio remembers the name and location of the application last
used to edit the source file for any item of the same type and creator.
If necessary, you will be prompted to choose an application and to
specify where the application is located.

Portfolio opens the application, which in turn opens the source file
for editing.

3. Make the changes you want, save the file, and quit the applica-
tion.

After quitting the editing application, you are returned to Portfolio.

To copy a source file:

1. Select the item and choose “Copy Original…” from the Item
menu.

2. In the file directory dialog box, locate and open the folder where
you want the copy to go.

3. Click “Save.” Portfolio copies the source file into the folder you
specified.

Note: You can also copy source files by dragging them from Gallery
windows onto the desktop or into folders.
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Warning!

Be very careful when using the
“Delete Original…” command to
delete source files—the files are
deleted immediately. Once you
confirm the deletion within
Portfolio, the files cannot be
recovered.

To move a source file:

1. Select the item in the Gallery window.

2. Choose “Move Original…” from the Item menu.

3. In the file directory dialog box, locate and select the folder you
want the original file moved to.

4. Click the “Select” button at the bottom of the directory dialog
box.

Portfolio moves the source file into the folder you specified.

Note: “Move Original…” moves the source file from its current
location to the one you specify. If the source file is locked, “Move
Original…” does not move the file, but makes a copy of it in the new
location.

Portfolio automatically updates the catalog after you move a file.

To delete a source file:

1. Select the item in the Gallery window.

2. Choose “Delete Original…” from the Item menu.

3. Click “Cancel” if you change your mind or “OK” to confirm
that you want to delete the file.

Using Portfolio with other products
You’ll find that Portfolio works directly with many products to make
cataloging fast and easy. This section describes how to use Portfolio
with various products.

QuarkXPress 3.31 and above

You can transfer cataloged images to your QuarkXPress documents,
and save thumbnails of your documents for use in Portfolio catalogs.

Note: On the Macintosh, Portfolio includes two very helpful Quark
XTensions in the Portfolio Quark XTensions folder. “Extensis
QX-Drag&Drop” allows you to place images from Portfolio into
Quark documents (see below). “Visions Edge Preview Editor Lite”
allows you to save a full-color thumbnail of your Quark document.
Refer to the accompanying instructions for help. (Extensis cannot offer
technical support for Preview Editor Lite.)

M
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To transfer images in Portfolio to QuarkXPress:␣

Note: On the Macintosh, the QX–Drag&Drop XTension (in your
Portfolio Extras folder) must be installed in Quark’s XTension folder.

1. From an open Portfolio catalog, select the image(s) you wish to
drop into your QuarkXPress document.

2. Drag and drop the images into your open Quark document.

Each image is placed in a new picture box at the cursor location in
the document.

To attach a thumbnail in QuarkXPress:␣

1. When saving a QuarkXPress document, make sure that “In-
clude Preview” is selected in the QuarkXPress Save dialog box.

This will save a black-and-white thumbnail of the first page of your
Quark document.

Adobe PageMaker 6.5

You can transfer cataloged images to your PageMaker documents, and
save thumbnails of your documents for use in Portfolio catalogs.

To transfer images in Portfolio to PageMaker 6.5:

1. Select the images in Portfolio.

2. Drag the images to your PageMaker document.

To include a thumbnail and preview in PageMaker:

• Choose “Save As...” from PageMaker’s File menu, and select
Save Preview in the “Save As...” dialog box.

When you save the file, a thumbnail and preview are created from
the first page of the document.

Adobe Photoshop 3.0 and 4.0

You can save thumbnails, keywords and captions from your Photoshop
documents for use in Portfolio catalogs.

To include a thumbnail and preview in Photoshop:

1. Choose “General...” from the Preferences submenu in
Photoshop’s File menu.

2. Click “More.”

3. In the Image Previews section of the dialog box, select “Always
Save.”

4. Click “OK.”

M

M

M

M
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To include keywords and captions in Photoshop:

1. Select “File Info” from Photoshop’s File menu.

2. Enter your caption in the caption field.

3. Click “Next” to switch to the “Keywords” panel.

4. Click “OK” to close the dialog box.

Adobe Illustrator 7.0

Illustrator automatically saves a thumbnail that Portfolio can display.

Macromedia Freehand 7.0

You can save thumbnails and previews of your Freehand files for use in
Portfolio.

To attach a thumbnail and preview in Freehand:

1. Choose “Preferences…” from Freehand’s File menu.

2. Select “Importing/Exporting.”

3. Select “Include Fetch™ preview.”

When you save the file, a vector thumbnail and preview are created,
increasing the size of your file. If your file has small dimensions,
contains tiled fills, or is crowded with many objects, select “Bitmap
Fetch™ preview size” to minimize the increase.

Adobe Persuasion 4.0

Persuasion automatically creates a thumbnail and preview for your file
from the first slide.

Using items in other applications
Portfolio lets you use item source files in other publications or presen-
tations. For example, you might include a Freehand illustration in a
PageMaker publication or import a QuickTime movie into a Persuasion
presentation. You can drag and drop items between applications, or
copy them to the Clipboard to paste into other documents.

Dragging and dropping items into other applications
On the Macintosh, you can drag items from Gallery windows into any
application that accepts items dragged from other applications. Extensis
provides drag and drop support for some applications that do not
currently provide this capability (such as QuarkXPress).

In Windows, Portfolio lets you drag and drop items from Gallery
windows into any application that supports OLE drag-and-drop. Check
your application’s documentation for information on OLE drag-and-
drop support.

M
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To drag and drop an item:

1. In Portfolio, select an item (or several items) in a Gallery
window.

2. Drag and drop the item(s) into an open document in the receiv-
ing application.

If the receiving application can accept the item’s file type, the item
will be placed in the application.

Copying items
Copying an item from Portfolio and pasting it into another application
places the entire source file (or the selected portion of it) into the
receiving document. You can use this method to transfer any catalog
item to another application, whether or not that application is “Portfolio
aware.” The receiving document increases in file size by the size of the
original file, or the selected portion of the file.

The file format of the items you copy may change when placed on the
clipboard—for instance, copying an image from a Preview window
copies the file as a PICT on the Macintosh and as a Bitmap (BMP) in
Windows. The format change depends on the item’s original file type.
If you need to preserve the image’s original format, you must manually
import the image into the application.

To copy an item:

1. In Portfolio, open the item’s Preview window.

2. Choose “Copy” from the Edit menu.

3. In the receiving application, choose “Paste” or “Paste Special”
from the Edit menu.

Choosing “Paste Special” allows you to specify a file format for the
item you are pasting.
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Viewing item properties
When you want to know more about an individual item than Portfolio
displays in either the Thumbnail or List view, select the item and
choose “Item Properties…” from the Item menu. The “Item Properties”
dialog box described below appears. You can have as many “Item
Properties” dialog boxes open as memory permits.

To do this… Follow this procedure…

Open an Item Properties dialog box Select one or more items in either view and choose “Item Properties…” from
the Item menu.

Edit the item description Enter or change the description in the “Description” field of the General tab.

Add a keyword to the item Type a keyword in the text field above the Keyword list in the Keywords tab,
then click “Add.” The new keyword is added to the item, unless “Allow Only
Keywords from Master Keyword List” is selected in the Master Keywords tab of
the “Catalog Administration” dialog box and the keyword is not in the list.

Add a Master Keyword to the item Select one or more keywords in the Master Keyword list in the Keywords tab,
then click “Assign.” The selected keywords are assigned to the item.

Remove a keyword from the item Select one or more keywords in the Keyword list in the Keywords tab, then
click “Remove.” The selected keywords are removed from the item.

Edit a field value for the item Select the field you want to edit in the Fields tab, then click “Edit.” Type the
new value in the dialog box that appears, then click “OK.” The new value is
applied to the item.

The Item Properties dialog box

C

BAThe Item Properties dialog box contains
four tabs that display detailed information
about an item.

A The General tab displays information
about the item’s source file. You can
edit the item’s description in this tab;
see “Using descriptions” in Chapter 3
for more information.

B The Keywords tab displays the
keywords associated with the item
and the Master Keywords list. See
“Using keywords” in Chapter 3 for
details on keywords.

C The Fields tab displays all of the
custom fields associated with the
item. You can change editable field
values in this tab. See “Using custom
fields” in Chapter 3 for details.
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The Catalog Properties dialog box

C

BA

D

The Catalog Properties dialog box
contains four tabs that display detailed
information about a catalog.

A The General tab displays the catalog
name; creator name; language; size;
creation date; number of items;
number of keywords; and pathname.

B The Options tab includes options
related to how items are added to or
updated in the catalog. See “Setting
catalog update options” in Chapter
3, “Creating and Managing
Catalogs,” for more information.

C The Exclude (Exclude Strings in
Windows) tab allows you to exclude
certain files when adding or
updating files to the catalog. See
“Excluding files” in Chapter 3,
“Creating and Managing Catalogs,”
for complete information.

D The Statistics tab shows the
keywords in use by the catalog, and
displays the number of items
associated with each keyword. See
“Viewing keywords” in Chapter 3,
“Creating and Managing Catalogs,”
for more information.

To do this… Follow this procedure…

Open Catalog Properties dialog box Choose “Catalog Properties…” from the Catalog menu.

Generate a list of catalog keywords Click “Calculate…” in the Statistics tab. The keywords appear in the “Keywords”
list box, along with the number of times they appear in the catalog.

Find all items with a specific keyword Double-click that keyword in the “Keywords” list box in the Statistics tab.

Export the catalog’s keyword list Click “Export Keywords” in the Statistics tab, then specify a filename and
location in the directory dialog box that appears.

Find all items on a specific volume Double-click the volume in the “Volumes” list box in the Statistics tab.

Viewing catalog properties
When you want to know more about an entire catalog, open the catalog
and choose “Catalog Properties…” from the Catalog menu. The
“Catalog Properties” dialog box described below appears. You can have
as many “Catalog Properties” dialog boxes open as memory permits.



37

This option… Does this…

Confirm Delete from Catalog When selected, the “Confirm Delete” dialog box appears when you
delete an item from the catalog.

Show Options Dialog on Add/Update When selected, the “Options” tab of the “Catalog Properties” dialog
box appears when you add items to or update items in a catalog.

Autoplay Movies and Sounds When selected, movie and sound files are played automatically in
Preview windows; you don’t need to click the Play button.

Display Welcome Screen When selected, a dialog box prompting you to create a new catalog
or open an existing one appears when you launch Portfolio.

Fit Preview Images to Window When selected, images are automatically scaled to fit Preview
windows. When unchecked, images appear at 100% and scroll bars
appear in the window to allow you to view the entire image.

QuickFind Opens New Gallery (Windows only) When selected, the results of searches performed using the
QuickFind button on the toolbar appear in new Gallery windows. If
unchecked, the search results replace the contents of the current
Gallery.

Default Open Mode Choose the access level with which Portfolio will open the catalog
(Reader, Editor, Publisher, or Administrator; see “Catalog access
levels” in Chapter 4, “Catalog Administration,” for more information
on access levels).

Setting preferences
You can customize Portfolio to suit your working style and work more
productively by setting preferences using the “Preferences…” com-
mand in the Edit menu.

To set or change preferences:

1. Choose “Preferences…” from the Edit menu.

The “User Preferences” dialog box appears.

2. Select the options you want.

The Portfolio preferences are described in the table below.

3. Click “OK.”

Portfolio preferences
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Printing catalog items
Although you will typically find and select a catalog item either to edit
the source file or use it in another document, you might want to print
from the catalog itself—to show to a client, for example, or to evaluate
items for possible use in a document.

When you choose “Print…” from the File menu, Portfolio prints the
contents of the active window. To print thumbnails or a list of catalog
items, print from the Gallery window. To print a single full-size image,
print from a Preview window.

When you choose “Print…”, the resulting dialog box reflects the active
window:

• If the active window is a Preview window, you see a standard
“Print” dialog box that contains no special options for Portfolio.

• If the active window is a Gallery window, the print dialog box
includes the options described in the table below.

Troubleshooting printing problems
• “Print Using Actual Images” with Quality set to “Best” is a printer-

intensive task. Some printers are not equipped with enough memory
to support the amount of data being downloaded to the printer. If
you experience problems, try switching to the “Better” or “Good”
setting.

• Thumbnails rotated in the catalog are printed at their original
orientation when using “Print Using Actual Images”

This option Choices Prints this…

Header A text header centered at the top of the page. The header appears in the
same font as the Gallery window display.

Footer A text footer centered at the bottom of the page. The footer appears in the
same font as the Gallery window display.

Number Pages Page numbers on each printed page. Enter a starting page number in the
“Number Pages From” text box if you don’t want the first page to be 1.

Print Using… Actual Images Prints thumbnails using the original source files if available.  This option
generally yields a higher-quality output, but can be time intensive because
Portfolio must open and process each item’s source file when creating its
thumbnail.  Thumbnails in the catalog are substituted for any actual
images that are not found.

Thumbnails in Catalog Always prints from the thumbnail images available in the catalog.

Quality Best Provides the highest-quality output and the slowest print times.
Better Provides medium-quality output at moderate print times.
Good Provides the lowest-quality output but the fastest print times.

Gallery window printing options
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3—Creating and Managing Catalogs

This chapter describes how to create and modify Portfolio catalogs. To
carry out most of the procedures described, you must have Publisher
access to the open catalog. See Chapter 4, “Catalog Administration,”
for more information on catalog access privileges.

Specifying a default catalog
You can specify a default Portfolio catalog. The default catalog opens
automatically when you first start Portfolio.

To specify a default catalog:

1. Open or create the catalog you want to use as the default.

2. Choose “Set Default Catalog” from the File menu.

A checkmark appears in front of the menu command. To deselect
the catalog, just choose “Set Default Catalog” a second time or
specify another catalog as the default.

Creating a new catalog
New catalogs created from within Portfolio are empty. To add items,
see “Adding and updating items in a catalog” later in this chapter.

Note: You’ll notice that the Portfolio catalogs you create have an
“.fdb” filename extension, even on the Macintosh. This is to ensure
cross-platform access to your catalogs. Portfolio also creates a
supporting file for each catalog; this file has an “.adm” extension, and
cannot be opened on its own.

To create a new catalog:

1. Choose “New…” from the File menu.

2. Specify a name and location for the new catalog in the directory
dialog box that opens, then click “Save.”

Portfolio creates the catalog and opens a blank Gallery window.

3. Add items to the catalog as described in “Adding and updating
items in a catalog” later in this chapter.

Adding and updating items in a catalog
You can easily add items to a catalog from within Portfolio, or from the
desktop or folders. In addition, you can update the catalog after you’ve
made changes to your files or moved or deleted files.
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Tip

Portfolio’s default settings are
adequate for cataloging most
files under most circumstances.
You can change these options
at any time, return to the
original defaults, or create your
own. For more information
about these options, see
“Setting catalog update options”
later in this chapter.

The Catalog Properties dialog
box appears only if “Show
options dialog on Add/Update”
is selected in the “User
Preferences” dialog box. By
default, this option is selected,
so you will see the Catalog
Properties dialog box until you
reset your preferences.

When using the “Add Items...” command from the Catalog menu, a
directory dialog box appears allowing you to locate and select the files,
folders, or volumes that you want to add to the open catalog.

When you add to a catalog, Portfolio displays the Options tab of the
“Catalog Properties” dialog box so that you can change options before
continuing. When you click “OK,” Portfolio adds the items and
presents status screens so you can track the progress.

To add catalog items:

1. Launch Portfolio and open a catalog.

2. Choose “Add Items…” from the Catalog menu, or select files
directly and drag them into the Gallery window.

A directory dialog box appears if you chose “Add Items….”

3. Locate the file, folder, or volume that you want to add. The
volume that contains the files must be mounted.

To add… Follow this procedure…

A single file Select the file and drag it into the Gallery
window. Or, in the directory dialog box, select
the file you want and click “Open.”

All files in a folder or a volume Drag the folder into the Gallery window. Or,
in the directory dialog box, select the file or
folder you want and click “Folder.”

All files and subfolders within Drag the folder with subfolders into the
a folder or volume Gallery window. Or, in the directory dialog

box, select the folder or volume you want,
select the “Include Subfolders” option and
click “Folder.”

Files whose file Select the “Catalog All Types” option when
types are not listed the Options tab of the “Catalog Properties”

dialog box appears.

4. If you used the “Add Items...” command, click “OK” in the
directory dialog box.

The Options tab of the Catalog Properties dialog box appears.

5. Review and change any settings.

Choose an option from the “Modify Method” pop-up menu to
specify how to add or update the files.

6. Click “OK.”

Portfolio scans the volume containing the source files, displays the
“Cataloging Status” dialog box, and examines each file before
adding it to the catalog.
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To update catalog items:

1. Launch Portfolio and open a catalog.

2. Choose “Update Items” from the Catalog menu, or select files
directly and drag them into the Gallery window.

Portfolio searches for the source file of each item and updates it in
the catalog. If a source file cannot be found, you are prompted to
locate it manually.

The Options tab of the “Catalog Properties” dialog box

C

B

A

Use this illustration and the table on the
following page to explore the cataloging
options that Portfolio provides.

A Specify whether to add or update;
include item paths in the keyword
list; and thumbnail quality.

B Select the types of items to catalog.
You can also add, edit or delete file
types.

C Select the item attributes to extract.

D Click “OK” to add or update items
using the current settings. D

Setting cataloging options
Unless you set your preferences otherwise, Portfolio displays the
“Catalog Properties” dialog box whenever you add items to an open
catalog by:

• Choosing “Add Items…” from the Catalog menu.

• Dragging items into a Gallery window from the desktop or a folder.

If you prefer not to see this dialog box in these circumstances, choose
“Preferences…” from the Edit menu, then deselect “Show Options
Dialog on Add/Update” in the “User Preferences” dialog box.
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Cataloging options

Option Choices Description

Modify Method Add Adds items only if they do not already exist.
Ignores items if they already exist.

Update Updates items only if there have been changes.
Ignores items if they do not exist in the catalog.

Add and Update Adds items if they do not already exist and
updates items if they already exist.

Add Unconditionally Adds items even if they already exist.
Update Unconditionally Updates items even if there have been no

changes. Use this setting to regenerate
thumbnails when an item’s newly created
thumbnail is not being displayed in the catalog.

Include Pathname None Filenames and pathnames are not added to the
keyword list.

File Name Adds the item’s filename to the keyword list.
File & Folder Name Adds the item’s filename and immediate folder

name to the keyword list.
Path Name Adds the item’s filename and all of its folder

names, but ignores the volume name.
Path Name with Volume Adds the item’s full path, including filename,

all folder names and volume name.

Thumbnail Quality High Creates high-resolution thumbnail.
Medium Creates medium-resolution thumbnail.
Low Creates low-resolution thumbnail.

File Types Catalog All Types Catalog all file types.
Catalog Following Types Catalogs only the file types that are selected in

the list box. To select or deselect a file type, click
its name.

Add… Click to add a new file type to the supported file
types list. See “Adding a file type” later in this
chapter for details.

Edit… Click to modify the selected file type.
Delete Click to delete the selected file type from the

supported file types list.

Extract Keywords (Macintosh Only) Looks for and extracts any keywords saved with
source files.

Extract Description (Macintosh Only) Looks for and extracts any description saved with
source files.

Extract Thumbnail (Macintosh Only) Looks for and extracts any preview image saved
with source files. (If you are adding or updating
QuickTime movies, we recommend that you do
not use this option. You will get a larger thumbnail
for the movie if you let Portfolio create it rather
than extract it.)

Skip Files Without Thumbnails Does not catalog files that Portfolio cannot find or
create thumbnails for.

end
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Excluding files
As you build and modify catalogs, you can tell Portfolio to skip files of
a certain type or name.

• If you want to skip files of a specific type, you can deselect or
delete that file type in the file types list box located in the Options
tab of the “Catalog Properties” dialog box, as described in “Setting
catalog update options” earlier in this chapter. (For more informa-
tion about file types and Portfolio, see “Adding a file type” later in
this chapter.)

• If you want to skip files with a specific file name, you can create
an exclusions list.

You create an exclusions list by specifying an explicit set of file names.
This list is stored in the catalog.

To add items to the exclusions list:

1. Choose “Catalog Properties…” from the Catalog menu.

The “Catalog Properties” dialog box appears with the General tab
open..

2. Open the Exclude tab.

The following table describes the options in the Exclude tab.

To… Do this…

Add an entry Type the filename you want into the text box, then click
“Add.” Letter case is irrelevant.

Portfolio searches each pathname for the text string you
enter. For example, if you enter “ext,” Portfolio excludes the
file “EXTRA.GIF” as well as “extensis_logo.eps.” Likewise,
all files in the “Extreme” folder will be excluded.

Delete an entry Select it in the list box, then click “Delete.”

3. When you have made all the changes you want, click “OK” to
save the exclusions list.

Adding a file type
When you add items to a catalog, you’ll notice that the Options tab of
the “Catalog Properties” dialog box lists the types of files Portfolio
recognizes. While you can easily modify this list, it’s important to
remember that Portfolio can recognize and catalog any file type,
whether it’s in the list or not. It’s simply a matter of selecting the
“Catalog All Types” option button above the list when adding items.
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Tip

To add a file type when you
are not sure of its extension or
type, click “Same As…”. In the
directory dialog box that
appears, select an example of
the type of file that you want
to add, then click “Open.” Click
“OK” in the “File Type” dialog
box.

Still, there may be times when you want to add file types to this list, or
remove file types from it altogether. For example, you might want to
add the file type for an application you use frequently, but whose file
type is not currently supported.

Depending on the file types of the items you add, Portfolio will either
generate a thumbnail for an item, extract a thumbnail from its source
file, or display a file icon rather than a thumbnail.

To modify the list of file types:

1. Choose “Catalog Properties…” from the Catalog menu.

The “Catalog Properties” dialog box appears.

2. Select the Options tab.

The following table describes the file type options.

To… Do this…

Add a file type Click “Add…”; the “File Type” dialog box
appears. In the Extension text box, type the
three-letter file extension for the Windows file
type you are adding. In the Mac File Type text
box, enter the four-letter code for the
Macintosh file type you want to add. In the
Description text box, type a description.
Select “Store in Catalog” if you want the file
type to be added to the list stored with the
Catalog file (so others can use the settings).
Select “Store in Preferences” if you want the
file type to be added to the list stored in the
Portfolio Preferences file.
When all settings are correct, click “OK.”

Edit a file type’s settings Select it in the file type list box, then click
“Edit…”; the “File Type” dialog box appears.
Change the settings you want, then click
“OK.”

Remove a file type Select it in the file type list box, then click “Delete.”
File types that you delete are removed from the list
altogether; if you just want a file type to not be
added to your catalog, deselect the checkbox in
front of its name.

3. Click “OK” to close the dialog box and save the revised list.
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Macintosh File Type Windows Extension Format

BMPp .bmp or .dib Windows and OS/2 bitmap

FPIX .fpx FlashPix

GIFf .gif Graphics Interchange Format (GIF)

JPEG .jpg Joint Photo Experts Group (JPEG)

PCDI .pcd Kodak Photo CD

PICT .pct Macintosh picture

.pcx PC PaintBrush

PNGf .png Portable Network Graphics

8BPS .psd Adobe Photoshop 2.5–4.0

.ras SUN Raster

TPIC .tga Truevision Targa (TGA/TARGA)

TIFF .tif Tagged Image File Format

Raster file types for which Portfolio generates thumbnails

Supported file types
The following tables list the file types Portfolio generates thumbnails
for, separated by raster and vector/text formats.

Macintosh File Type Windows Extension Format

.ai Adobe Illustrator 3.0 - 6.0

.cdr CorelDRAW 3.0–7.0 drawing

.cgm or .ctm Computer Graphics Metafile

.ch3 or .sy3 Harvard Graphics 3.0

.cmx CorelDRAW Presentation Exchange 5.0

.drw Micrografx drawing

.dsf Micrografx Designer 6.0

.dwg AutoCAD drawing r12–13

.dxf AutoCAD drawing Interchange

EPSF .eps Encapsulated Postscript

.fmv Frame Vector Metafile

Vector and text file types for which Portfolio generates thumbnails

(continued)
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Macintosh File Type Windows Extension Format

.hgl Hewlett-Packard Graphics Language

PDF .pdf Adobe Acrobat

.pic Lotus 1-2-3 graphic

SLD3 .ppt Microsoft PowerPoint 2.0–4.0

.ps PostScript Interpretive

.wmf Microsoft Windows Metafile

.wpg WordPerfect Graphics 1.0–20

Vector and text file types for which Portfolio generates thumbnails (continued)

The next table lists Macintosh file types that may have thumbnails
available for Portfolio to extract. For more information, refer to the
documentation for the applications in the table.

Macintosh File Type Format

CWGR ClarisWorks 3.0–4.0 drawing

CWPT ClarisWorks 3.0–4.0 painting

drw5 Deneba Canvas 5.0

AGD2 Macromedia Freehand 7.0

AB65 Adobe PageMaker 6.5

MuAd Multi-Ad Creator

..CT SciTex CT

XDOC QuarkXPress

Macintosh file types from which Portfolio extracts thumbnails

Multimedia formats supported by Portfolio
Macintosh File Type Windows Extension Format

MooV .mov QuickTime Movie

.avi AVI Video (Windows only)

AIFF .aif AIFF Sound file

WAVE .wav WAVE Sound file

MIDI .mid MIDI Sound file

sfil .snd Macintosh Sound file

3DMF .3dmf QuickDraw 3D Metafile
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The Master Keywords Palette

DC

A

The Master Keywords palette displays
a catalog’s Master Keywords
alphabetically, and can be resized and
placed anywhere onscreen.

A Type a Master Keyword name to find
that keyword quickly. This is useful
for large Master Keyword lists, when
scrolling would be time-consuming.

B The catalog’s Master Keywords
appear in this list box. Drag Master
Keywords from the palette and drop
them in Gallery windows to assign
them to any selected items.

C Click to assign the selected Master
Keyword(s) to the selected item(s) in
a Gallery window.

D Click to find all instances of the
selected Master Keyword (or just
double-click the keyword). The
search results appear in the current
Gallery window.

B

Tip

You can customize Gallery
windows to show keywords in
thumbnail view; see “Customiz-
ing Gallery windows” in
Chapter 2, “Using Catalogs,”
for details.

Item keywords also appear at
the bottom of Gallery windows
in List view.

Using keywords
Each item in a catalog has certain information associated with it, such
as filename, file type, volume, and so on. Each item can also have one
or more keywords associated with it. A keyword is a word or phrase
that you associate with a particular item, and a good keyword list can
be a valuable tool for finding the material you need in a catalog.

In addition, a catalog can include a preset list of Master Keywords.
Master Keywords can help maintain consistent keywords among the
items in a catalog, or across catalogs; see Chapter 4, “Catalog Adminis-
tration,” for information on maintaining the list of Master Keywords.

Each item can have an unlimited list of keywords associated with it. In
a network environment, a catalog administrator can control who is
allowed to edit keyword lists for each catalog (see “Catalog access
levels” in Chapter 4, “Catalog Administration,” for details).

Viewing keywords
You can view keywords and Master Keywords in several ways:

• In the Master Keywords Palette

• In the Item Properties dialog box

• In the Catalog Properties dialog box
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M

To display the keywords for an item:

1. Select the item, then choose “Item Properties…” from the Item
menu.

The “Item Properties” dialog box appears.

2. Select the Keywords tab.

The item’s keywords appear in a list box on the left. Master Key-
words appear on the right.

3. Click “OK” when you are finished viewing the keywords.

To display the keywords for an entire catalog:

1. Choose “Catalog Properties…” from the Catalog menu.

The “Catalog Properties” dialog box appears.

2. Select the Statistics tab.

3. Click “Calculate….”

The keywords for all items in the catalog and the number of
occurrences of each keyword appear in the list box on the left.

Note: You can export the catalog’s item keywords to a text file by
clicking “Export Keywords….” This is useful if you want to import
those keywords into the catalog’s Master Keywords list.

Extracting keywords from source files
Portfolio examines all source files for keywords created in their native
applications when you add them to or update them in a catalog. The
“Extract Keywords” option must be selected in the Options tab of the
“Catalog Properties” dialog box for this to occur; see “Setting catalog-
ing options” earlier in this chapter for details.

As Portfolio catalogs items, extracted keywords are added to the
keyword list for each item that contained them. Unless “None” is
selected in the “Include Pathname” pop-up menu in the Options tab of
the “Catalog Properties” dialog box, Portfolio adds the filename and
folder name of each item as keywords.

Entering and editing keywords manually
In addition to extracting keywords from source files, you can enter
them into a catalog manually and edit both extracted and manually
entered keywords. You can also enter Master Keywords, provided you
have administrative privileges—see Chapter 4, “Catalog Administra-
tion,” for details.
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To enter keywords manually:

1. Select the item to which you want to add keywords, then choose
“Item Properties…” from the Item menu.

The “Item Properties” dialog box appears.

2. Select the Keywords tab.

3. Type a keyword in the text box, then click “Add.”

The keyword is added to the Keywords list.

Note: If the catalog administrator has restricted keyword additions
to only those in the Master Keyword list, Portfolio checks your
additions against the list and notifies you of any “illegal” keywords.
See “Entering Master Keywords” in Chapter 4, “Catalog Adminis-
tration,” for more information.

4. Continue adding keywords, then click “OK.”

You can use the “Edit Keywords…” dialog box to edit item keywords.
For instance, if you ever need to remove a keyword from more than one
item, you can do so in one swift action rather than individually.

To edit a keyword list:

1. Select the item(s) for which you want to edit keywords, then
choose “Edit Keywords…” from the Item menu.

The “Edit Keywords” dialog box appears.

The options in the “Edit Keywords” dialog box are described below:

To… Do this…

Add a new keyword Type a keyword in the text box, then click “Add.” The
keyword is added to the keyword list when you click
“OK.”

Assign a keyword Select the keyword in the list, then click “Assign.” The
keyword is assigned to any selected items that it was
not previously assigned to.

Delete a keyword Select a keyword in the Keyword list box, then click
“Delete.” The keyword is removed from the list and any
selected items when you click “OK.”

3. Click “OK” to save the changes to the item’s keywords list.

To abandon the changes you made to the keywords, click “Cancel.”

Note: You can select more than one keyword at a time for deletion,
and you can add as many keywords as you want before clicking
“OK.”
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Tip

To enter the same description
for a number of different items,
you can use the Clipboard. For
example, if you scan a number
of images using the same
scanner settings, you can enter
the description of the settings in
the description field for one of
the items, then “Copy” to copy
the description to the Clipboard.
From the Clipboard, you can
paste the same description into
the description field for each of
the remaining items.

M

Using descriptions
In addition to adding keywords to any item, you can add a description
up to 32,000 characters long. You can use the description field to keep
track of any information about the source file that you might find useful
or important. For example, the description for a photo image could
include notes about who took the original photograph, copyright, and
agency or contact information.

If the original application provides a way for you to enter and save
descriptive text with the source file, Portfolio can extract this informa-
tion automatically as it catalogs the item on the Macintosh. Otherwise,
you can add or edit a description after cataloging. In a network environ-
ment, a catalog administrator can control who edits descriptions.
For details on catalog administration, see “Setting catalog privileges” in
Chapter 4, “Catalog Administration.”

Extracting descriptions from source files
Portfolio examines all source files for descriptions created in their
native applications when you add them to or update them in a catalog.
The “Extract Description” option must be selected in the Options tab of
the “Catalog Properties” dialog box for this to occur (see “Setting
catalog update options” earlier in this chapter for more information).

Entering and editing descriptions manually
In addition to extracting descriptions from source files, you can enter
them into a catalog manually. You can also edit both extracted and
manually entered descriptions.

To enter or edit a description manually:

1. Select the item to which you want to add a description, then
choose “Item Properties…” from the Item menu.

The “Item Properties” dialog box appears with the General tab
selected.

2. Type a description in the Description text box, then click “OK.”

The description is added to the item.

Note: If the Description text box is unavailable, you do not have
permission to edit descriptions for items in the open catalog. If you
are working in a network environment, check with your catalog
administrator.
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Using custom fields
If custom fields have been defined for a catalog, you can change their
values (or contents). For example, you can add photographers’ names to
the “Photographer” field in a catalog of photographic images. Some
custom fields even allow more than one entry, so you could enter the
number of times an image has been published in a single field.

Note: You must have Editor access or above to a catalog in order to
change its custom field values. To define new custom fields, you require
Administrator access. See “Catalog access levels” and “Adding
custom fields” in Chapter 4, “Catalog Administration,” for complete
details.

To use custom fields:

1. Select an item in a Gallery window and choose “Item Proper-
ties…” from the Item menu.

The “Item Properties” dialog box appears with the General tab
open.

2. Open the Fields tab.

All custom fields for the catalog appear in the list box.

3. Select the field you want to change, then click “Edit….”

The “Edit” dialog box for the field type appears.

4. Type the appropriate value in the text box and click “OK.”

If you enter a value that is incorrect for the field type, clicking “OK”
produces no result. You must re-enter the proper value type.

5. Click “OK” to close the “Item Properties” dialog box.
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Tip

You can also use the Find and
Replace feature to enter the
same custom field values for a
number of different items. Just
select the items you want to
add the value to and choose
“Replace…” from the Catalog
menu. Select the appropriate
custom field from the pop-up
menu, leave the “Find” text box
blank and enter the new value
in the “Replace With” text box.
Select the “Search selected
items” option button and click
“OK.” The new value is added
to the custom field for each
item you selected.

Replacing keywords and custom field values
You can easily replace keywords and custom field values in your
Portfolio catalogs. For example, if you need to modify a keyword for
several items in a catalog, you can do so automatically. Similarly, if the
print date for a collection of images slips by a week, you can replace
the incorrect date in the “Publish Date” field for all the images in the
catalog at once.

To replace keywords and custom field values:

1. Choose “Replace…” from the Catalog menu.

The “Find and Replace” dialog box appears.

2. Select the keyword or field to search in the “Fields to Search”
pop-up menu.

The pop-up menu lists all of the custom fields defined for the
catalog, as well as a keywords option.

3. Enter the keyword or value you want to replace in the “Find”
text box.

If you are replacing a custom field value, be sure to enter an
appropriate value for the field you selected in step 2.

Note: If you are replacing keywords in a multi-user catalog, the
catalog must allow keyword addition or no action is taken. Check
with your catalog Administrator or see “Entering Master Keywords”
in Chapter 4, “Catalog Administration,” for more information.

4. Enter the replacement keyword or value in the “Replace With”
text box.

5. Select the appropriate option button for your search.

You can search only the selected items in the Gallery, or the entire
Gallery.

6. Click “OK.”

Portfolio searches for and replaces all instances of the keyword or
custom field value you specified. A dialog box appears informing
you of the number of replacements performed.

end
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This chapter describes how to maintain Portfolio catalogs and how to
use catalog functions in a multi-user environment.

Maintaining a catalog
Catalogs—especially large ones—that are heavily used and frequently
updated can become out-of-date. In addition to routinely backing up all
catalogs and source files (and keeping the backups in a safe place), it is
a good idea to perform other housecleaning tasks regularly as well.
Portfolio provides the catalog manager or administrator with tools that
can help with routine catalog maintenance.

Exporting catalogs as text files
The “Export…” command in the File menu lets you save a text
representation of catalog items. Exporting is a useful way of keeping
track of the items in a catalog outside of Portfolio.

To export a catalog as a text file:

1. Select the items you want to export.

2. Choose “Export…” from the File menu.

A directory dialog box appears.

3. Specify a name and location for the export file, then click
“Export.”

The catalog is exported to the text file you specified.

Removing items from a catalog
The “Delete Items…” command lets you clear a catalog of unwanted or
out-of-date items or references.

To remove specific items from a catalog:

1. Select the items you want to delete in the Gallery window.

2. Choose “Delete Items…” from the Catalog menu.

The “Delete Items” dialog box appears.

3. Select “Delete from Catalog” and click “OK.”

Note: Select “Delete from Gallery” if you want to remove the item
from the Gallery window only. The item remains in the catalog when
you click “OK.”

4—Catalog Administration

Tip

You can also remove an items
from a Gallery by selecting it
and pressing Delete. To remove
the item from the catalog, press
Option+Delete (Macintosh) or
Ctrl+Delete (Windows).
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Checking for missing files
You can easily determine if any file references in a Portfolio catalog are
no longer valid.

Note: Portfolio searches for missing files on mounted volumes only. If a
volume containing item source files is not mounted, Portfolio will not
detect the files.

To check for missing files:

1. Open the catalog.

2. Choose “Missing Files…” from the Catalog menu.

Portfolio checks the catalog and lists all missing files in the Missing
Files dialog box.

3. Select the files you want to update and click “Update…”.

You can also delete files you no longer want in the catalog by
selecting them and clicking “Delete.”

Recovering damaged catalogs
Should you ever have trouble opening a Portfolio catalog and suspect
that it may have been damaged, you may be able to recover it.

To recover a catalog:

1. Choose “Recover…” from the File menu.

A directory dialog box appears.

2. Locate the catalog you want to recover and click “Open.”

A second directory dialog box appears.

3. Type a new name for the recovered catalog, select where you
want to save it and click “Save.”

A dialog appears as Portfolio checks the catalog and performs any
necessary repairs. When the recovery is complete, a recovery report
dialog box appears to provide details of the items that were and
were not recovered.

4. Click “OK.”

When the recovery is finished, open the recovered catalog to make
sure that all its items are intact.
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Catalog access levels
A Portfolio catalog is protected if a password is required in order to use
it. There are four access levels that can be established for a catalog:
Administrator, Publisher, Editor and Reader. Each level can have its
own password.

The Administrator level is usually assigned to the catalog creator alone.
This level allows access to all catalog functions, including creating and
editing custom fields. The Administrator is responsible for setting all
access level passwords, and is the only user who can change the
passwords. In addition, the Administrator is the only user who can
create or modify a catalog’s Master Keyword list, as well as specify
whether other users can add their own keywords to the catalog.

Note: A shared catalog cannot be accessed by other users when it is in
use by its Administrator. Consequently, you cannot switch to Adminis-
trator level if other users also have the catalog open.

Portfolio access levels are inherited; that is, the Administrator level
includes the privileges of all other levels (in addition to its other
privileges), the Publisher level includes the privileges of the Editor and
Reader levels, and so on.

Tip

You can change the catalog
access level you’re using by
choosing “Access…” from the
Catalog menu, and entering the
proper password in the dialog
box that appears. Note that you
cannot change to Administrator
level if other users are also
using a shared catalog.

Tip

For more information about
network access to Portfolio
catalogs, see “Using Portfolio on
a network” later in this chapter. If
you need to know a password
for a catalog and are unsure of
who the Administrator is, open
the General tab of the “Catalog
Properties” dialog box to see the
name of the administrator.

Feature Reader Editor Publisher Administrator

View a catalog ✓ ✓ ✓ ✓

Search a catalog ✓ ✓ ✓ ✓

Preview items ✓ ✓ ✓ ✓

Copy item source files ✓ ✓ ✓ ✓

Edit descriptions, keywords ✓ ✓ ✓
and custom field values

Save Galleries ✓ ✓

Save finds ✓ ✓

Update items ✓ ✓

Add items ✓ ✓

Move item source files ✓ ✓

Delete item source files ✓ ✓

Define custom fields ✓

Assign passwords ✓

Catalog access levels
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Setting catalog passwords
Multiple users can use a catalog simultaneously across a network,
within the restrictions of their access privileges. Therefore, password
protection is strongly recommended when a catalog is available to
multiple users. Protection is not necessary, however, if you are the
single user of a catalog on your own computer.

You can set passwords when you first create a catalog, or if you have
Administrator privileges for another catalog.

To set or change catalog passwords:

1. Open the catalog.

2. Choose “Administration…” from the Catalog menu.

The Catalog Administration dialog box appears with the
Keywording tab open.

3. Open the Passwords tab.

4. Click “Set Password…” in the “Administrator” field.

The “Set Password” dialog box appears.

5. Type the new password in each text box, then click “OK.”

You enter the new password a second time to verify that it is correct.
Passwords must be between 4 and 12 characters in length.

6. Repeat steps 4 and 5 for the other passwords you want to set
(Publisher, Editor or Reader).

Note: Even if you only set a Reader password, users logging in as
Editor or Publisher will need that Reader password to gain access
to the catalog.

7. Click “OK” to close the Catalog Administration dialog box and
save the new password(s).

8. Close the catalog and reopen it to put the password(s) into
effect.

Once a catalog is password-protected, a passwords dialog box appears
when the catalog is opened. Users can then choose their access level
from the Access Mode pop-up menu, enter the correct password and
click “OK” to open the catalog.

Note: You can specify a catalog’s default access level in the General
tab of the “User Preferences” dialog box. See “Setting preferences” in
Chapter 2, “Using Catalogs,” for details.

Tip

To remove password protection
from a catalog access level,
open the “Set Password” dialog
box, leave the “New” and
“Confirm” fields blank, then click
“OK.”
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Entering Master Keywords
Establishing a Master Keyword list for a catalog can help you maintain
consistent keywords among the items in the catalog, or across catalogs.
With a Master Keyword list, you can ensure that only the keywords in
the list are used in the catalog.

You can enter Master Keywords manually, or you can import them
from an existing text file.

Note: Master Keywords are not dynamic. That is, when you change or
delete a Master Keyword in the “Catalog Administration” dialog box,
that Master Keyword is not automatically changed in any items to
which it’s been applied.

To enter Master Keywords:

1. Choose “Administration…” from the Catalog menu.

The “Catalog Administration” dialog box appears with the
Keywording tab open. The options in this tab are described below.

To… Do this…

Add a Master Keyword Type a keyword in the text box, then click
“Add.” The keyword is added to the Master
Keywords list.

Delete a Master Keyword Select a Master Keyword in the list box, then
click “Delete.” The keyword is removed from the
list only; not from items to which it is applied.

Rename a Master Keyword Select a keyword in the list, click “Rename,”
and type a new name for the keyword. The
keyword is renamed in the list only; not in items
to which it is applied.

Import Master Keywords Click “Import.” Locate and select the text file
containing the Master Keyword list to import
in the directory dialog box, then click “Open.”
The keywords in the file are added to the
catalog’s Master Keywords list.

Export Master Keywords Click “Export.” Specify a filename and location
for the exported Master Keyword  list in the
directory dialog box that appears, then click
“Save.” The file is exported as a text file with
carriage returns separating each keyword, and
is available for use in other Portfolio catalogs.

Restrict keyword entry Select “Allow Only Keywords from Master
Keyword List”. Users can only select keywords
from the Master Keyword list for catalog items.

2. Continue adding Master Keywords, then click “OK.”

Tip

You can export a catalog’s
keywords from the Statistics tab
of the “Catalog Properties”
dialog box, or create a text file
of keywords in a word process-
ing application, then import
those keywords into the Master
Keywords list in the “Catalog
Administration” dialog box.
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Parsing keyword phrases
Portfolio offers an option that allows keyword phrases (keywords
consisting of more than one word) to be parsed into individual key-
words. For example, adding the keyword phrase “Mother and child”
with keyword phrase parsing on would result in “Mother and child”,
“Mother”, “and”, and “child” being added to the item.

The advantage of parsing keyword phrases is it allows the user to do a
very fast “starts with” or “matches” search on words that would
otherwise not be found without using a “contains” search. In the
example above, searching on “starts with child” will only return the
item if keyword parsing is on.The disadvantage is more keywords in
the list and, hence, an increase in catalog size.

To enable or disable keyword phrase parsing:

1. Choose “Administration…” from the Catalog menu.

The “Catalog Administration” dialog box appears with the
Keywording tab open.

2. Check the “Parse Keyword Phrases” checkbox to turn keyword
parsing on.

3. Click “OK” to close the “Catalog Administration” dialog box.

Adding custom fields
Portfolio catalogs consist of a number of predefined fields. These
system fields, such as Filename, Path, Created and so on, categorize the
file information for each item in a catalog, allowing you to search for
specific items based on that information.

In addition to the system fields, you can define custom fields to hold
specialized information about catalog items. For instance, you might
want to add a field for Web site URLs to a catalog of GIF files, or a
“Photographer” field to a catalog of photographic images.

There are four custom field types from which you can choose:

• Date/Time, for date and/or time values. You could use this field type
to create a custom field for image publication dates.

• Decimal, for decimal point numeric values. This field type would be
useful for custom fields containing stock image prices.

• Number, for regular numeric values. This field type is ideal for
custom fields containing catalog part or stock numbers.

• String, for text values. This field type can be used for any number of
custom fields, including photographer or artist names.

Tip

It is recommended that the
Keyword Phrase Parsing option
be set when the catalog is
created (it is on by default) and
then never changed.
Changing this setting after
items have been added to a
catalog can result in inconsis-
tent search results, since some
items will contain parsed
keywords and others will not.
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Note: You must have Administrator access to a catalog in order to add
custom fields. Users with Editor access privileges and above can edit
custom field values; see “Using custom fields” in Chapter 3, “Creating
and Managing Catalogs,” for details on editing custom field values.

To add custom fields to a catalog:

1. Choose “Administration…” from the Catalog menu.

The “Catalog Administration” dialog box appears with the
Keywording tab open.

2. Open the Custom Fields tab.

3. Click “Add….”

The “Custom Field Definition” dialog box appears.

4. Type a name for the field in the “Name:” text box.

5. Choose the field type from the “Type:” pop-up menu.

The field type determines the values that can be entered into this
field. Field types cannot be changed once they are defined.

6. If you chose “String” in step 5, specify the maximum number of
characters allowable in the field in the “Length” text box. If you
chose “Decimal,” specify how many places are allowable after
the decimal point.

7. Select the appropriate remaining options in the dialog box.

The options are described below.

To… Do this…

Make the field sortable Select “Indexed.” The field is added to the list
of sortable fields that appears when you choose
“by Other…” from the View menu. Searching is
also faster on indexed fields.

Allow multiple field entries Select “Multiple Values.” Different users can
specify their own values for this field in a multi-
user catalog. This is useful if, for example, a
user wants to list all instances of an image’s
publication in a single field.

8. Click “OK” to define the custom field.

9. Click “OK” to close the “Catalog Administration” dialog box.
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Using Portfolio on a network
A single Portfolio catalog can contain references to source files on
multiple hard disks, network servers, CD-ROM discs, or removable
disks, whether these media are mounted or not. When Portfolio needs
to retrieve a source file that resides on a network volume, it automati-
cally mounts that volume, prompting for a volume password when
required.

If a source file is stored on removable media, such as floppy disks or
CD-ROMs, Portfolio prompts for the disk by name. Portfolio also
prompts for source files that have been moved or renamed.

In a network environment, a shared catalog can be on a network file
server or on any one user’s Macintosh or PC, as long as the Macintosh
or PC is properly networked.

Network security protection
Your organization is authorized to use as many copies of Portfolio as
designated in your site license agreement. When you run Portfolio on a
network, the application checks the network to see how many copies of
Portfolio with the same serial number are running. If the program finds
that more duplicate serial numbers are in use than are in the site license
agreement, an alert box appears. Click “OK” to close the alert box.
Another user must quit Portfolio before you can launch the copy that
you want to use.

If you did not purchase a Portfolio site license, only one copy of
Portfolio per serial number may be in use on your network.

For access to the… The folder that contains it…

Catalog Must be located in folders to which catalog Administrators have network-level read
and write access. Users with Publisher and Editor access also need network-level
read and write access to add, update and delete items. Other users need at least
read access.

Source files Can be located in folders to which different users have different levels of network
access:

No access Allows users to search, print thumbnails, view thumbnails, edit
keywords or descriptions (if permitted), or view most item information.

Read access Allows users to get full item information, preview, print images, copy
items to the Clipboard, or copy source files.

Write access Allows users to edit, move, or delete source files (with the proper
Portfolio access privileges).

Network access to catalogs and source files
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Network environment concerns
In a typical network scenario, many users would open Portfolio, locate
items they want, and leave Portfolio running in the background while
they switch to other applications to edit source files, work on other
documents, read e-mail, and so forth. Meanwhile, at any given time,
only some of those users would be actively using the catalog to search
for and preview items they might be interested in, while fewer still
might be adding or updating items, keywords, or descriptions.

The greater the number of users who have a catalog open, the slower
individual searches will be, depending on what tasks the users are
performing in Portfolio. The speed of the network and the server can
also affect the performance of Portfolio.

If a computer’s system crashes or is shut down while its user has a
shared catalog open, Portfolio will examine the catalog for damage and
temporarily make other users wait until the verification is complete.
Therefore, users should always close and quit to exit a catalog rather
than shut off or restart their systems.

If you want to limit who can write to or read from a catalog, you can set
passwords as described in “Catalog access levels” earlier in this
chapter. Whether or not your catalog is password-protected, it is
essential that you also set up the network access conditions described in
the table below.

Managing source files
There are many ways to organize the source files for items in a Portfo-
lio catalog. Each strategy has advantages and disadvantages, but
considering the options and planning ahead can save you time in the
long run and significantly increase Portfolio’s usefulness to you and
your workgroup.

One of the key benefits of using Portfolio is that you do not need to
remember where a source file is located or what it is called. However,
because Portfolio can use filenames, folder names, or entire pathnames
as keywords, and because you can then use those keywords to help in
searching, a rational plan for naming and organizing files and folders is
helpful.

Each workgroup must ultimately decide what works best for its own
situation based on how the group works and how work flows through it.
Here are a few suggestions that might help in your planning.

Tip

In cross-platform environments,
be sure that network server and
volume names are the same for
each network path. This allows
Portfolio to locate files between
platforms.

Tip

If someone deletes an item
from a multiuser catalog and
that item is in one or more of
your saved Galleries, an “Item
Deleted” icon appears in place
of the item thumbnail. Choose
“Refresh” from the Catalog
menu to remove these icons
from the Gallery.



Organizing source files
One of the most obvious ways to organize files into folders is to set up
a series of folders for each project, client, or category (for example,
travel, business or architecture). Within a folder, use subfolders to
partition related files appropriately.

Another approach is to organize files into folders by file type, by parent
application, or by department of origin (for example, Marketing, Sales
or Publications).

Once you’ve organized your files into folders, it’s easy to include the
files into Portfolio catalogs.

Naming source files
Use naming and organizing strategies together to make the most of
keyword searching in Portfolio. Once you have decided how to
organize your files, consider the following alternatives for naming
them:

• Use file extensions to indicate file type. This is very important when
using Portfolio in a cross-platform environment, where you’ll want
to keep Windows file naming restrictions in mind when naming
Macintosh files.

• Use number or alphabetic prefixes to help sort items in ways that
matter for the kinds of files you use. For example, you might use
frame numbers for images from a single photo shoot or counter or
time code readings for sounds, movies, or images digitized from
video or audio tape.

end
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Appendix A: Portfolio Shortcuts

This appendix lists the Portfolio menu command hotkeys and keyboard
shortcuts for both the Macintosh and Windows. For an online reference
to more shortcuts, refer to Portfolio’s online Help.

To do this… Macintosh Hotkey Windows Hotkey

Create a new catalog Command+N Ctrl+N

Open an existing catalog Command+O Ctrl+O

Print a Gallery Command+P Ctrl+P

Cut Command+X Ctrl+X

Copy Command+C Ctrl+C

Paste Command+V Ctrl+V

Select all items in a catalog Command+A Ctrl+A

Open/close the Master Keywords palette Command+K Ctrl+K

View Gallery in Thumbnail view Command+T Ctrl+T

View Gallery in List view Command+L Ctrl+L

Find specific items in a catalog Command+F Ctrl+F

Find all items in a catalog Command+' Ctrl+'

Add items to a catalog Command+E Ctrl+E

Update items in a catalog Command+U Ctrl+U

View catalog properties Command+J Ctrl+J

View item properties Command+I Alt+Enter

Preview an item's source file Command+B Ctrl+B

Edit an item's source file Command+M Ctrl+M
(with last selected editing application)

Create a new Gallery Command+G Ctrl+G

Close a catalog Command+W Ctrl+W

(continued)

Menu command hotkeys
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To do this… Press… Notes

Move one item to the right in a Gallery window Right-arrow key Not available in List view

Move one item to the left in a Gallery window Left-arrow key Not available in List view

Move one item down in a Gallery window Down-arrow key

Move one item up in a Gallery window Up-arrow key

Scroll down one screen in a Gallery window Page Down

Scroll up one screen in a Gallery window Page Up

Go to the top of a Gallery window Home (Macintosh)
Ctrl+Home (Windows)

Go to the bottom of a Gallery window End (Macintosh)
Ctrl+End (Windows)

Go to the first item in a Gallery window row Home Windows only; Thumbnail view only

Go to the last item in a Gallery window row End Windows only; Thumbnail view only

To do this… Macintosh Hotkey Windows Hotkey

Customize a Gallery Command+D Ctrl+D

Save a Gallery Command+S Ctrl+S

List all saved Galleries Command+; Ctrl+Q

Rotate a thumbnail 90˚ clockwise Command+] Ctrl+]

Rotate a thumbnail 90˚ counter-clockwise Command+[ Ctrl+[

Quit Portfolio Command-Q Alt+F4

Refresh a Gallery window Command+R Ctrl+R

Edit item keywords Command+Y Ctrl+Y

Perform catalog administration tasks Command+H Ctrl+H

Menu command hotkeys (continued)

Navigational shortcuts
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To… Do this…

Preview an item Double-click the item in either Gallery window view
Double-click the item thumbnail in List view
Double-click the item thumbnail in the "Item Properties" dialog box

Search for items based on a keyword Double-click the keyword in List view
Double-click the keyword in the "Item Properties" dialog box
Double-click the keyword in the "Catalog Properties" dialog box
Double-click the keyword in the Master Keywords Palette

Remove an item from a Gallery window Select the item and press Delete

Remove an item from a catalog Select the item and press Option+Delete (Macintosh)
Select the item and press Ctrl+Delete (Windows)

Regenerate a thumbnail for an item Select the item and hold down the Option key (Macintosh) or Shift key
(Windows) while choosing "Update Items" from the "Catalog" menu.

Functional shortcuts

end





67

Appendix B: Portfolio Case Studies

This appendix provides three scenarios designed to help you better use
Portfolio in your workplace. While none of the scenarios may fit your
exact work patterns, you can easily apply elements of each in order to
use Portfolio to its best advantage.

Scenario 1
The art department for a hardware manufacturer has a large digital
collection of company and product logos, product photographs, catalog
layout documents, and so on. The department consists of 10 artists and
designers, each of whom stores files on his or her local hard drive, or
on the department file server.

Once a week, all of these files are backed up onto removable cartridge
drives by the department administrative assistant.

The art department staff are primarily Macintosh users. However, one
designer uses a PC, and the department administrative assistant uses
both a Macintosh and a PC. Other groups within the company, who
regularly need access to the art department files, are PC users.

Problem

The company staff has no way of knowing what images and documents
they have or where they are located: when sharing files, they must take
the time to track down what they need. And while the art department
administrative assistant knows that each backup cartridge contains a
week’s worth of files, determining what each disk contains or what
each file on it represents also takes time.

Solution

The administrative assistant indexes the contents of the cartridge drives
into a single Portfolio catalog, adding new items and updating existing
ones each week after the files are backed up. The assistant assigns
keywords and descriptions to the items (if the artist or designer didn’t
do so in the source files), and creates custom fields to record which
product, season, catalog, and so on the images and documents pertain
to.

Each employee who needs access to the files has a copy of Portfolio.
The administrative assistant, acting as catalog administrator, gives the
them Reader access privileges so that they can search the catalog but
not modify it.
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Scenario 2
A digital imaging company that sells royalty-free photographs and
illustrations to both Macintosh and Windows users.

Problem

The company president wants to create a comprehensive, easy-to-
distribute electronic catalog of all their images. The catalog must
include image thumbnails, part numbers, prices and collection names
and volumes.

Solution

The company’s creative director creates a Portfolio catalog containing
all of the images, with corresponding custom fields for part numbers,
prices and collection names and volumes. The creative director then
customizes the Thumbnail view to display these custom fields, then
saves that view as the default Gallery.

The company licenses the Extensis Portfolio Content Publisher’s
Toolkit to obtain read-only browser versions of Portfolio, and the rights
to distribute them. The catalog, which can be viewed by both
Macintosh and Windows users, is distributed to prospective buyers
along with the Portfolio browsers.

Note: For details on the Portfolio Content Publisher’s Toolkit and the
read-only browser version of Portfolio, call (800) 796-9798.

Scenario 3
An individual designer who has created images in various formats for
her clients, as well as a collection of royalty-free artwork and stock
photographs on CD-ROM.

Problem

The designer needs to keep track of all of her files, but doesn’t really
need to share this index with anyone else.

Solution

The designer uses Portfolio to catalog all of the image files contained
on various Zip disks, CDs and her Macintosh hard drive. She creates
custom fields to indicate which of her work was used for which client,
and where and when they were published.

Using the Portfolio Content Publisher’s Toolkit and read-only browser
versions of Portfolio, she could also create and distribute a catalog as
an electronic portfolio for prospective clients.

Note: For details on the Portfolio Content Publisher’s Toolkit and the
read-only browser version of Portfolio, call (800) 796-9798.

end
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